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Lab 01: Introduction 

Introduction - Basic principles of GIS 

GIS is a technology used to view and analyze data from a geographic perspective. 

GIS links location to information, and layers that information to give a better understanding of how it 

interrelates. A GIS map is therefore composed of many layers, or collections of geographic objects 

that are alike. You choose what layers to combine based on your purpose. The following map 

contains four layers, Cities, Rivers, Countries, and Topography (elevation data). 

 Remember: A Map is made up of Layers 

 

 

In the preceding map, the “Cities” layer is made up of many different cities, and the “Rivers” layer of 

many different rivers. The same is true of the “Countries” layer. Each geographic object in a layer, - 

each city, river, lake, and county – is called a Feature. 

 Remember: Layers contain Features 
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In any GIS software, geographic features are represented as one of three geometrical forms, a 

polygon, a line, or a point. Polygons represent things large enough to have boundaries, such as 

countries, lakes or other large tracts of land. Lines represent narrow, linear features, such as roads, 

rivers or pipelines. Points are used for things too small to be represented as polygons, such as cities 

on a map of the United States, or schools on a map of DC. Polygons, lines and points are collectively 

called Vector Data. 

 Remember: Features can take the form of Points, Lines and Polygons, and are known 
collectively as Vector Data. 

Not all layers contain Features, The topological (shaded relief) layer you see above is not a collection 

of geographic objects in the same way the other layers are. It is a single continuous expanse that 

changes from one location to another according to the height/depth of the Earth‟s surface. A 

geographic expanse of this type is called a Raster. We use Rasters because unlike rivers, or 

countries, things such as elevation, temperature, rainfall or wind speed have no distinct shape. 

A Raster is a matrix of identically sized square cells or pixels (much like a digital photograph). Each 

cell represents a unit of surface area, and contains a measured or estimated value for that location. 

When displaying this information, colors are assigned to the individual pixel values along a ramp 

scale. 

 Remember: Layers also contain Rasters 

 

There is much more to an individual feature than its shape and location, and GIS files have the 

potential to incorporate this additional information. There is a great amount of information that may be 

gathered about any one feature. A country has population, a capital, a system of government, leading 

imports and exports, average rainfall, mineral resources and many other things. Roads have grading 

systems, speed limits, number of lanes, and one or two-way systems.  

Information about the individual feature of any one layer is stored in a table. The table has a record 

(row) for each feature in the layer, and a field (column) for each category of information. These 

information categories are called attributes; therefore, these tables are commonly referred to as 

“Attribute Tables”. Each object (or “feature”) on a GIS map is linked to a row of information in an 

attribute table. 

 Remember: Layers contain Features, and each Feature is linked to a row of information in the 
Attribute table 
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Now, let’s get started making our own map!!! 
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Lab 01: Exercise 

The ArcMap interface and adding data 

1. Start ArcMap by double-clicking the ArcMap icon on your computer desktop. 

(Alternately, click the “Start” menu, point to “All Programs”, point to “ArcGIS” and select 
“ArcMap”) 

 

2. You may receive the following 
welcome screen, if so, select “a 
new empty map,” and press OK. If 
you do not receive this screen, 
ArcMap has selected a blank map 
by default. 

 

 

 

 

 

 

 

3. You are now looking at the basic ArcMap screen with its various menus and tools. To begin with, 
we will add some data. From the “File” menu, select “Add Data”. (You will notice that the “Add 
Data” icon is replicated on the main tool bar. You will find that this is the case for many of the 
tools and functions within ArcMap.) 

 

4. In the “Connect to folder” window, navigate to the location of your Tutorial folder: 
“D:\Student\GIS_Lab_2011”, and click OK. 
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You will only have to do this step once. By establishing this connection, you will be directed to 
your GIS lab folder each time you return to it and add new data to the map. It‟s like creating a 
shortcut. 

 

 

5. Now open the folder “Lab_01”, and select the file named “Regions”.  

(If a warning box pops up when you attempt to add data at any point, just click OK) 

 

 

6. The outline of Ethiopia should now be visible in your map window. Notice that on the left hand 
side of the screen you have a box containing a short list, beginning with the word “Layers.” This 

Table of 

Contents 
Data Frame 

Tools used to query and zoom data frame 
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box is called the Table of Contents, and it lists the names of the various data layers in the map. It 
shows the color symbol used to draw each layer, and tells you by means of a check mark, 
whether or not the layer is visible. 

7. Left click on the various (+) & (-) boxes in the Table of Contents window, noticing how the Table of 
Contents changes. It works in a similar way to a data tree within Windows Explorer. Click on the 
checked box next to the “Regions” Layer to turn the layer off, click it again, and the map 
reappears. 

8. The main window of the ArcMap interface is called the Data Frame. It is where your data is 
displayed and manipulated. The various toolbars can be found both above and below the Data 
Frame. Many of their functions are also replicated in the standard drop down menus to the top 
left. 

9. In order to make the map more detailed, we will add further layers. Add additional data by using 

either the “File” menu, or click on the “Add data” icon . You will be taken back to the “Lab01” 
folder. Select “Cities.shp” and holding down the “ctrl” key select “Rivers.shp” and “Lakes.shp”. 
Click Add. The fact that you now have multiple layers in your map is represented in your Table of 
Contents.  Make sure that you see the “Regions”, “Cities”, “Lakes” and “Rivers” shapefiles in 
your Table of Contents on the left of your screen. 

 

Navigation using the ArcMap toolbars 

10. Hold down your left mouse button over “Cities.shp” and drag it down below your “Regions.shp” 
file. What happened to your map? The Table of Contents window controls the various layers of 
your map. Whichever layer is on top in the Table of Contents, will also be the topmost layer of 
your map. Move the other layers around to see how this property works.  

IMPORTANT NOTE: In order to drag files to reorder them, your table of contents must be in the 
Display mode, look at the bottom of the table of contents and make sure that the Display tab is 
selected). Click on the Source tab at the bottom of the Table of Contents. Now that you are in 
this tab, you can see where each data source came from. Try 
to reorganize your shapefiles so “Regions” are on the top 
again. Notice that you cannot move the order of your shapefiles 
unless you are in the Display tab. Click on the Display tab 
again at the bottom of your Table of Contents in order to change order of your shapefiles in the 
Table of Contents. 

 

11. On your screen are various tool icons. By moving your mouse over each icon in turn, a pop-up 
box will alert you to the name and/or function of that particular tool. Many of the tools, though 
new, are self-explanatory, and many others, such as the “Drawing” tools, are quite similar to 
those found in basic Windows programs. The most basic toolbar within ArcMap contains the 
navigational tools: 

 

 

12.  Locate the “Zoom In” tool . Using this tool, draw a box around Addis Ababa by left click 
and hold while you draw a box. Now, select the tool that looks like a hand. 

This is called the “Pan” tool. Use it to „grab‟ the map and move it around in order to see other 
areas of your map. 

 

13. On your toolbar, you will see the scale box.      
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14. Using the “zoom in” / “zoom out”  or the “fixed zoom in” / “fixed zoom out”  tools, 
adjust the map until your scale shows approximately “1:2,000,000”. You may also manipulate the 
scale box by directly typing the required scale. 

15. Switch to the identify tool  and click on 
any one of the diamonds representing the 
cities. The “Identity Results Dialog” shows 
you various facts about the feature that you 
have selected. Using the Identify tool, you 
can see the information associated with 
each city in the pop up dialog. 

 

 

 

 

16. Now click on the tool called “Full Extent”.  This resizes your map to cover the full area of your 
largest feature (all of Ethiopia). 

17. Click on the tool for “Previous Extent”  and it will take you back to your last zoomed in view. 

Now that we have explored a little on how to maneuver the basic tools in the map viewer format, 
we will now look at the data that are behind the shapefiles, these data are very similar to an 
excel table. 

 

Feature Attribute Tables 

In GIS, a feature on a map may be associated with a great deal of information – more than can be 
displayed at any given time. This information is stored in an Attribute Table. A data layer‟s attribute 
table contains a row (or record) for every feature in the layer and a column (or field) for every attribute, 
or category of information. When you clicked on one of the „Cities‟ points in Step 17 (above), the 
information you saw in the identity results dialog was the information stored in the Attribute Table for 
the “Cities” Layer. 

 
18. Click on the “Add data” icon. You will be taken back to the “Lab_01” subfolder. Select “Zones.shp” 

and click “Add”. You may have a warning message pop up, just press the OK tab; we will cover 
this in the next lab.  In the table of contents, right click on the new data layer “Zones.shp”, and 
click the option “Open Attribute table”. 

19. Scroll down the table. There are 74 records (record one is numbered as 0 – see first observation 
in the table under column heading FID), one for each zone in Ethiopia. 
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20. There are multiple attributes, or fields. The “FID” field contains a unique identification number for 
every record. The “SHAPE” field describes the object geometry (Point, Line, Polygon). Among 
other attributes is the Zone name (EASE_ZoneN), its corresponding Region code. 

 

21. The order in which the fields are displayed can be rearranged, much like in excel. Click once on 
the field name in order to highlight it, then, click a second time (you should see a white arrow), to 
drag it to your preferred location. Rearranging the data like this has no adverse effects on the 

database or map. 

22. Field data may also be sorted. 
Right Click on the field 
“NAME”. You will have option 
to sort “Ascending” or 
“Descending”. Depending on 
the field type, the data will be 
sorted in alphabetical or 
numerical order. Sort and 
resort this field and observe 
the effects on the table 
arrangement. 

 

 

 

23. Records, as well as fields can be highlighted. When a record is highlighted in a table, its 
corresponding feature is highlighted in the map. A highlighted record or feature is said to be 
“Selected”. 

24. Right click on the field “NAME” and Sort Ascending. Click the grey tab at the left edge of the first 
record in the table, (Afder). This record is now selected. See below. 
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25. Move or minimize the attribute table in order to see the map more clearly. The Afder zone should 

be highlighted. You may have to use the “Zoom to Full Extent”  to spot the selected district. 

 

 

26. To unselect this record, Select the “Options” tab on the bottom right-hand side of the Attribute 
table, and click “Clear Selection”. 

27. You can also select objects in ArcMap directly from the map window. Close the attribute table for 
now. Pan to the Southern Area, and select a zone using the following “selection” tool from the 

main toolbar.  

 

28. Reopen the attribute table for 
“Zones.shp”. On the bottom-center 
of the attribute table, click on the 
button “selected”. The district you 
selected should appear as the 
only record in this list.  

See how the link between table 

and map works; Items selected in 

the map are also selected in the 

table, and visa versa. When you 

select a zone, and you see that 

more is being highlighted than just 

the zone, this is because the 

select tool selects the related area 

with each area file in the table of 

contents. So, not only did you select Afder Zone, but you also selected Somali Region. You can 

open the Regions Attribute table and click on the “Selected” tab, you will see that Somali Region 

is selected. 
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29. Now unselect this record by selecting the “Options” tab on the bottom right-hand side of the 
Attribute table, and click “Clear Selection”. Close the attribute table. If you still have an area that 

seems selected on your map, you can use the “Unselect” button  to unselect everything in 
the Data Frame. 

 

Symbolizing Features 

Symbolizing features means assigning them colors, markers, sizes, widths, patterns, transparency 
and other properties by which they can be recognized on a map. Data Layers added to Arc Map have 
default Symbology. Points are displayed with small circles or diamonds, and polygons (or shapes) 
have a fill color and outlines. The colors for points, lines and polygons are randomly chosen. 

 
30. First, turn off the “Zones” layer, by clicking the little black check mark to the left of the layer name 

“Zones”. 

31. Then, use the “Zoom to Full Extent”  button to return to a view of entire Ethiopia. 

In the Table of Contents, double-click on the color symbol for “Regions” layer.  

The Symbol Selector dialog opens.  

 

32.  The scroll box on the left contains predefined 
symbols. The options frame on the right allows 
you to pick specific colors and set outline widths. 
Choose a color of your preference for both Fill 
and outline. 

 

 

 

 

 

 

 

 

33. Next, we will work on the Symbology for the Cities. In the table of contents, double click on the 
point symbol for the “Cities” layer. The Symbol Selector dialog opens once again. In the scrolling 
box of predefined point symbols, click “Circle 1”. In the “Options” frame, click the drop-down 
arrow to change the symbol size to 4 points. 

Again, choose your color preference. On the map, the Cities should display with your new 
symbol. 

 

34. Choose a new color for the “River” layer also by double clicking on the line symbol underneath the 
layer in the Table of contents, as you did for the “Zones” and “Cities”.  

35. Experiment with the colors and options for the various layers. You are not tied to those suggested 
by this lab. 
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 Labeling: All maps contain textual information. Features in ArcMap are identified with labels that 
make use of information from fields in the Attribute table to identify a particular set of features. 

 

36. For the moment, turn off your “Cities” and your “Rivers” layer. 

37. Double left click on the “Regions” layer, The pop-up window you now see is called the “Layer 
Properties” dialog. The mapmaker controls many properties of an individual layer from this 
dialog, and we will work with this quite regularly in the future, but for the moment, click on the 
“Labels” tab. (see below) 

38. Click on the arrow for the drop down menu on the Label Field option, and choose “Region_Nam”.  

 

39. Using the text tools, change the label to bold size 8. For more advanced options, click on the 
button “Symbol”, then the button “Properties”, and finally the tab “Mask”. 

This will allow you to put a halo on your text. Choose a white halo, of 1.5 points.  

Click OK repeatedly to accept these changes and exit out of the Layer Properties dialog. 

You are encouraged to explore the other tabs within the labeling function at your leisure.  For 
example, you can explore the “Label Styles” under Pre-defined Label Style to see different sizes 
of text and shadowing styles. 

 

Saving your progress 

At this point, you have changed and customized quite a few features of this map. In order to preserve 
these changes, we will now save your progress as a “Project file”. 

A project file in ArcMap carries the file extension .mxd. An .mxd file saves each component of a 
working map, from the files you have opened, to the colors you have chosen. This allows you to edit 
and return to a particular map, repeatedly. 

 

40. From the “File” menu in the top left corner of your screen, choose “Save As”. Navigate to the GIS 
folder on the C: drive; C:/Student/GIS_Lab/Lab01, and save as “Lab01_”Yourname”.mxd. It is 
always a good idea to save your map repeatedly while working. 
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The Layout View 

 

41. You now have a basic GIS map of Ethiopia. The next step is to prepare this map for printing. 

42. First, make sure that your “Regions”, “Cities”, and “Rivers” shapefiles are all turned on by 
checking the checkmark box next to the layer name in the table of contents. Also, go to the “Add 
Data” button, and add the “Lakes” shapefile to your datascreen. 

43. The map window that you have been working in up to now is called the “Data View”. 

We will now move to a different map window called the “Layout View” to prepare the map for 
printing. The “Data View” is where you perform the majority of your GIS editing work, while the 
“Layout View” is where you arrange your map(s) along with preferred graphics for printing or 
export. To navigate between these two views, there are two small tabs located on the bottom 
left-hand corner of the main map window. 

44. The “Layout View” is represented by the white sheet of paper, and 
the “Data View” by the little globe. Click over and back between 
these tabs, and observe the changes. 

45. The third little icon, represented by the double arrows, is the 
“Redraw/Refresh” button. Use this button at any time, if you feel 
your map has not redrawn fully after opening or editing. 

46. When you have finished experimenting with the alternative map views, select the layout view.  

 

47. We want to select a paper setup that best fits the geographical nature of Ethiopia in order to use 
the most space on our page for our map.  

Click on the File tab in the upper 
left of your screen and scroll to 
“Page and Print Setup”. Make 
sure you select Landscape for 
the Orientation. Also click the 
checkmark to “Use Printer Paper 
Settings”. This will give you a 
dotted outline of how far you are 
able to expand your map. (see 
next step) 

 

 

 

 

 

 

 

48. Now, resize the window around your map of Ethiopia, 
so that it fits within the printable area.  
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49. Using the “Insert” menu, add a Title, Scale Bar, and North Arrow to your map. Using the insert title 
option, name your map “Ethiopia: Regions and Cities” (or something similar).  

There are many Scale Bars, and North Arrows styles to choose from. Pick your favorite. 

50. Return to the menu option “Insert” and click on 
“Legend”. 

 

 

 

 

 

 

51. In the Legend Wizard dialog that pops up, accept all the default options by Clicking “Next” 
repeatedly, and finally “Finish”. 

52. You will notice a small legend appear somewhere in the middle of your layout window. Position it 
correctly. 

53. If you wish to change the name of your layers in the legend, edit the corresponding text in the 
table of contents, and it will also change in the legend. Just click twice on the text in the table of 
contents to edit it, (as you would to rename a file in Windows Explorer). 

54. When you are happy with the appearance of your map, you can export this map as a .jpeg, by 
choosing the menu option “File”, scroll to “Export”, then save with as (Lab01_YOURNAME.jpeg) 
in your Lab01 folder following the instructions.  

 

 PLEASE MAKE SURE that you save the changes to your map before you continue. Your 
map should look similar to the one below (featuring your own color and style preferences of 
course). 
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Lab 02: Advanced symbology  

In the previous exercise, Rivers had the same line symbol regardless of their level of importance.  
This is sufficient for a basic navigational map, but most GIS maps are used as a visual interpretation 
of tabular data, therefore we will learn how to visualize such data in this lab. 

1. Open a new, blank map by clicking on the “New Map” button  in the upper left corner of your 
screen below the “File” button. 

2. From your Lab01 folder, add the file “Regions”, “Cities”, “Lakes” and “Rivers”. Reorder these files 
in the table of contents so that “Cities” are on top, “Rivers” are next, then “Lakes” and “Regions” 
is at the bottom. Remember: Your table of contents must be in the Display mode, look at the 
bottom of the table of contents and make sure that the Display tab is selected. 

3. From your Lab02 folder, add the “Roads” shapefile.  Uncheck the roads layer for now so you don‟t 
see it in your map frame; we will work on that later.  When you uncheck it, the roads layer should 
disappear from the Data Frame. 

4. Choose an appropriate color for the “Regions” layer, and then SAVE your project file as 
Lab02_YOURNAME to the Lab02 folder. 

5. Double-click on the layer name “Cities”; this will take you directly to the “Layer Properties” for the 
layer. Select the tab “Symbology”. 

6. In the “Show” box (see graphic), 
click on the option “Quantities”, 
and the sub-option “Graduated 
symbols”. In the “Value Field” 
dropdown list, select the Field 
name “POP”.  

7. Click “Apply”, but not OK. If you 
move your dialog slightly you 
will see that the city symbols 
have changed. The map is still 
a little too busy. Change the 
“Symbol size” to “from: 4 to: 
12”.  

8. Next, click on the “Classify” tab. 
This will take you to the 
“Classification” drop down 
menu (see graphic). 

 

9. Click on the arrow to the right of 
“Classes” and choose 2. Click 
on the arrow to the right of 
“Method” and choose “Manual”. 

10. Choose your “Break Values” to 
be 50,000 and the second the 
same as it displays the 
maximum value of population of 
a city. (See right) 

11. Press OK once you have finished 
step 10. 
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12. Now you are back to the Layer Properties Window. Double-click on the largest circle and chose a 
bright color to represent the cities that are greater than 50,000 people. Press OK.  

Double-click on the other circle and chose the symbol 
“Circle 1” in the left box, change the size to 4 and choose a 
color for these cities that display population under 50,000.  

 

 

 

13. Press OK repeatedly until you see the mapping screen again. 

14. Now it should be clearer where the cities of 50,000 are. Switch to your identify tool , click on 
one of the large circles. Scroll up and down in the “Identify” window that appears in order to read 
the attribute information. What is the city‟s name (SCHNM)? What is its population (POP)? What 
is the population calculated for the year 2000 (ES00POP)? 

 Now, SAVE YOUR WORK again as Lab02_YOURNAME!! 

15. Okay, now we are ready to add our roads.  Check the box next to your roads layer so it appears 
in your Data Frame. 

16. Wow! There are a lot of roads in Ethiopia, this is not very helpful. Double click on the roads layer 
(double-click on the word „Roads‟) in order to enter into the “Layer Properties” window. Click on 
the Symbology tab like you did when you were working on the cities.  

17. Click on “Unique Values” under the “Categories” option to the left of the Layer Properties window.  
(see below) 

18. Next, in the drop down menu on 
the Value Field, choose 
“SURFACE_TY” and then click 
on the tab “Add all Values”.   

19. Let‟s first see how the Primary 
roads connect to major cities 
(The primary roads here are 
labeled as AC or Asphalted 
Concrete).   

 

 

20. Double click to the left of the 
“AC” on the line symbol, this will 
take you to the “Symbol 
Selector” window, choose the 
“ExpressWay” symbol and 
press OK. You are now back at 
the “Layer Properties” window. 

 

21. Now, press “Apply” and move the “Layer Properties” window to the side so you can see your map.  
Now you are able to see the primary roads more clearly. 

 

22. Now let‟s label the other roads more clearly. Double click on the line next to the “Gravel” roads in 
order to the “Symbol Selector” again. Choose “Major Roads” symbol and press okay. Do the 
same for the roads labeled “ST” and “Earth in order to display them in a different color. Press 
“Apply”, and now all roads in your Data Frame should have the colors you chose to display. 
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23. When you have finished experimenting with the alternative Roads 
views, select the layout view (see step 44 in previous exercise if 
you need help).  

 
 
24. Using the “Insert” menu, add a Title, Scale Bar, and North Arrow to your map.  

25. Return to the menu option “Insert” and click on “Legend”. 

26. In the Legend Wizard dialog that pops up, except all the default options by Clicking “Next” 
repeatedly, and finally “Finish”. 

27. You will notice a small legend appear somewhere in the middle of your layout window. Position it 
correctly. 

28. If you wish to change the name of your layers in the legend, edit the corresponding text in the 
table of contents, and it will also change in the legend. Just click twice slowly on the text in the 
table of contents to edit it, (as you would to rename a file in Windows Explorer). 

29. When you are happy with the appearance of your map, you can export this map as a .jpeg, by 
choosing the menu option “File”, scroll to “Export”, then save following the instructions.  

 

Your map should look similar to the map below. 

 PLEASE MAKE SURE that you save the changes to your map before you continue. 
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Lab 03: Chloropleth mapping in Arc-GIS 

1. Open a new, blank map by clicking on the “New Map” button  in the upper left corner of your 
screen below the “File” button. 

2. From your Labo01 folder, add the “Regions” and “Lakes” shapefile. From your Lab02 folder, add 
the “Roads” shapefile. From your Lab03 folder add the “Woreda” shapefile.   

3. Double click on your “Woreda” 
layer in order to open up the 
“Layer Properties” window. And 
choose the “Symbology” tab.  

4. Click on the “Graduated Colors” 
under the Quantities option on 
the left side of the Layer 
Properties window. 

5. Choose Pop_04 in the Value 
Field, which is the population 
count per woreda in 2004. 

6. Classify your data accordingly by 
clicking on the “Classify” button 
and choosing classifications for 
your values (see step 8 of the 
previous exercise for help in the 
specific steps of classifying your 
data). When finished, press 
Apply and Okay. 

7. Now you are back to the Layer Properties Window. Left click on the numbers 
under the label column. Here you are able to change the labels of your data 
so when you make a map, the labels in the legend are clear (see right).  

 

 

 

8. Change all of your labels following the graphic above. Then click out of the labels box and press 
Apply and OK to return to the mapping screen. 

9. Make sure that your “Roads” layer is on and that you have classified your roads in hierarchical 
order. 

10. It is interesting to note spatially how population follows critical road infrastructure. But, is 
population count an appropriate measure to understand relationships between infrastructure and 
demography? Let‟s experiment with a different measurement to understand the differences and 
then create a map of both. 

11. Right click on the “Woreda” shapefile name in the table of contents and press copy. 

12. Scroll to the top of the Table of contents and right click on Layers tab  and choose 
“Paste Layers”. This will copy the same layer that you have already built on population count into 
the Table of Contents. You will now have two of the same “Woreda” layers in your table of 
contents. 

13. Now, double click on the new “Woreda” layer that you just copied into your table of contents and 
click on the “Graduated Colors” under the Quantities option on the left side of the Layer 
Properties window. 
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Population Density Population Count 

14. Choose Pop_Dens (this is the 
population density: average 
people per square kilometer 
by woreda). 

15. Classify your population 
density data by clicking on the 
“Classify” button and 
choosing classifications for 
your values. See the picture 
to the right under the label 
“Range” which shows how I 
classified my data. (look at 
step 6 above if you need 
help). When finished, press 
Apply and Okay. 

 

 

 

 

16. Left click on the Symbol tab above the color squares and choose Properties for all Symbols. 
Under the Outline Color tab, choose No Color for your outline color and then press OK until you 
exit Layer Properties. 

17. Notice how population density changes the further away one gets from the main infrastructure 
corridors in the highlands. Turn off and on the “Roads” layer in order to see the Density 
differences under the “Roads” corridors. 

18. Now add your “Regions” shapefile from your Lab01 folder. Left click on the colored square 
underneath the layer in the table of contents in order to open the Symbol Selector window. 
Choose the “Hollow” option and press okay. 

19. Turn off the “Roads” layer and just look at the differences between Population Density and 
Population Count. You can do this by turning off and on the Population Density “Woreda” layer. 
The layer beneath it is the Population Count layer. 
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Looking at the Population Density map, we can see that parts of SNNP and areas in the Northeast of 
Oromia have very high population density (see two maps below). In these high population density 
areas, what does the road infrastructure look like? Are they well connected? 

Later in the course, we will use spatial analysis to calculate distance, access, and remoteness to 
specific targets such as cities and markets in order to quantify these relationships! 

 

20. Now we will map both of the variables in the same layout window. Switch to the layout view, by 

clicking on the layout symbol in the bottom left and corner of the map window.   

 

21. Using the “Insert” menu, add a legend, and other appropriate cartographic elements to your map 
(North Arrow, and simple scale bar) for the Population Density map. 

 Save your map if you haven’t recently!  

22. In the layout window, resize the map, so that it is 
roughly one-quarter the size of the page by clicking 
once on the map and then dragging one of the 
corner sizing squares to diminish the size of the 
map. (You will also have to resize the legend and 
other elements). Move them to the top right hand 
corner of your layout. 

 

23. From the “Insert” drop down menu, choose the 
“New Data Frame” option. This will add a new 
empty map window to your layout. (see right) 

24. Now to add data to your new map window. In the 
table of contents, right-click on the “Woreda: 
Pop_04” layer in your first Data Frame that you 
have been working with up until now and scroll to 
“Copy”. 

25. Now right-click on the “New Data Frame” listing, and 
scroll to “Paste”. Repeat the process to add the 
“Regions” and “Lakes” layer to your second map 
window. 

 

26. In a multi-map set-up such as this. Only one map may be considered 
“Active” at any given time. This means that you can only work on the 
elements of one map at a time. To “Activate” a map, you can simply 
click on it in the layout view, or, you can right-click on the title of its 
corresponding set of layers in the table of contents, and scroll to 
“Activate”.  
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27. On switching to the “Data View” (remember, the little globe symbol),  you will notice that 
only the active map is shown.  

28. Test this by switching to the “Data View” and activating (from the table of contents) each map in 
turn. 

29. After understanding varying “Data View” interfaces, put the final touches on the maps (including 
adding another legend for the Population Count map) that you chose to make and export them 
as a .jpeg by going to the “File” button in the upper, left corner. Scroll to export and save as .jpeg 
in your Lab03 folder! 

 

Your layout window should now look something like this, but may have different colors! 
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Lab 04: Working with Attribute Tables in ArcGIS 

1. Open a new, blank map by clicking on the “New Map” button  in the upper left corner of your 
screen below the “File” button. 

2. From your Lab01 folder, add the “Cities” and “Lakes” shapefiles.  

3. From your Lab02 folder, add the “Roads” shapefile. From your Lab03 folder add the “Woreda”. 
From your Lab04 folder add the “Banks”, and “Microfinance” shapefiles. Reorder your shapefiles 
so that the point data are at the top of the table of contents, then the “roads”, and last the 
“woreda” shapefile.   

 Remember: Your table of contents must be in the Display mode, look at the bottom of the table of 
contents and make sure that the Display tab is selected. 

4. Choose an appropriate color for the “Woreda” layer, and then SAVE your project file as 
Lab04_YOURNAME to the Lab04 folder. 

5. Double-click on the layer name “Banks”; this will take you directly to the “Layer Properties” for the 
layer. Select the tab “Symbology”. 

6. In the “Show” box (see step 4 in the previous exercise), click on the option “Quantities”, and the 
sub-option “Graduated symbols”. In the “Value Field” dropdown list, select the Field name 
“TOT_Bank”. This value field represents the total number of banks in each town. 

7. Change the “Symbol size” to “from: 4 to: 16”. Next, click on the “Classify” tab. This will take you to 
the “Classification” drop down menu (see graphic on step 7 in previous exercise if you need 
help). 

8. Click on the arrow to the right of “Classes” and choose 6. Click on the arrow to the right of 
“Method” and choose “Manual”.   

9. Choose your “Break Values” to be 1, 3, 5, 7, 10, and the last number 
displays the maximum value of banks in a town. (See right)  

10. Press OK once you have finished step 9. 

 

 

11. Now you are back to the Layer Properties Window.  
Left click on the numbers 2-3 under the label 
column. Here you are able to change the labels of 
your data so when you make a map, the labels in 
the legend are clear.  

12. Change all of your labels following the graphic to the 
right. Then click out of the labels box and press 
Apply and OK to return to the mapping screen. 
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13. Now define thresholds for the “Microfinance layer following the same steps that you completed 
above. Use the variable “CLIENTS” in order to show how many people the microfinance project 
is serving 

14. I used the thresholds shown to the right, but 
you can experiment using different 
classifications in order to emphasize 
microfinance projects that are serving over 
50,000 people or emphasize small 
microfinance projects. The way in which you 
classify your data depends on what you hope 
to demonstrate and communicate to your 
audience. 

 

 

15. Although we are able to see where most of the Banks and Microfinance offices on a map, we 
should do a few calculations to understand how these banks and microfinance areas are 
represented spatially. 

16. Right click on the “Banks” and open your attribute table (Remember, this is the table that holds all 
of the underlying data that connects to our specific map layer) 

17. We have quite a bit of data in this file, such as: 
- Town name 

- Town population 

- Wereda name 

- Region 

- Zones 

- Population urban 

- Population rural 

- Population total 

- Government owned banks 

- Private banks 

- Total banks (this is what we mapped at first) 

18. Let‟s use our attribute table tools to summarize some of these data by administrative unit. Right 
click on the “Wereda” tab in your attribute and choose “Summarize”.  

19. This will take you to the Summarize window 
(See below) which gives you a variety of 
options on how to summarize your data. You 
will see that each variable in your attribute 
table is listed. Click on the + box next to the 
variable name. This will give you a drop down 
list of various calculations you can perform. 
You have a choice to summarize data by 
“Wereda” including: Minimum, Maximum, 
Average, Sum, Standard Deviation, and 
Variance. 

20. For now, let‟s Sum “GOV”, “PRIV” , and 
“TOT_Bank” by clicking on the + box next to 
the variable name. Choose “Sum” for each of 
these variables by clicking on the box next 
the Sum option. 

< 
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21. Last, save your table to your Lab04 folder: Lab04BankTable_YOURNAME and then press OK. 

22. This may take a moment for the table to calculate. It will then ask you if you want to add the result 
table to the map. Click YES. 

23. Close your attribute table and open the table that you have created by right clicking on the new 
table of contents and selecting “open”. You will now see the variables that you selected in the 
“Banks” layer have been summarized by Woreda. This table also includes a variable called 
“Count_Wereda” this is an automatic field that is calculated in ArcGIS that tells you how many 
observations per Woreda were calculated to sum each statistic that you chose. 

24. The bottom right of the table shows you the number of observations. Notice that there are 119 
observations in this dataset. This means, that at the time these data were collected, there were 
119 different Woredas that have a bank. BUT, note that the first observation in our table, there 
are 9 observations that didn‟t have a woreda name allocated to their bank location. Thus, there 
may be several other woredas that have banks, but were merely not labeled.   

25. Let‟s see where these banks are that do not have a Woreda label. Open the “Banks” attribute 
table. Right click on the Wereda variable and choose “Sort Ascending”. You will see the nine 
observations. Highlight these observations by dragging your arrow over the 9 observation tabs, 
or hold the shift button down and select each individually.   

26. Now move your table to the left of the screen so you can see the points that are highlighted in the 
map. They are primarily in the east part of the country.   (See below)  

 

27. Let‟s populate the missing Wereda labels by 
performing a spatial join on the “Bank” 
shapefile. Right click on the “Bank” layer and 
select “Join and Relate”. This will open the 
Join Data window. 

28. In the Join Data window. Select to “Join data 
from another layer based on spatial location”. 
This will present you with several options. 
Follow the example to the right and populate 
the fields as such. 

29. We choose that each point will be given the 
attributes from the polygon that it falls inside.  
This way, we will be able to population each 
bank point with the attributes from the 
Woreda file that we have. 

30. Save this new shapefile in your Lab04 folder 
as Banks2.shp 
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31. This may take a moment to process, the shapefile should add automatically to your map. 

32. Now, right click on your “Banks2.shp” file and open the attribute table. Notice that you have now 
merged the attributes from the “Banks” shapefile and the “Woreda” shapefile.   

33. Right click on the W_name attribute. Notice that each “Bank” point now has a Woreda attributed 
to its location. There are no blank values. 

34. Now, if you would like to create an improved table that has all of the information on Woreda 
name, you can summarize your “Banks2.shp” by W-name (as you did previously in steps 18-22 
of this exercise). 

35. Let‟s calculate another indicator in our attribute table. First, make sure that you do not have any 

observations selected/highlighted by clicking on the unselect tool  in the upper left of your 
screen.   

36. Now, open your Banks2 attribute table if it is not already open. Click on the Options tab in the 
bottom left of the Attribute table window and choose “Add Field”. We are going to create a new 
variable by calculating the percent of banks that are privately owned per town. 

37. Name your variable PctPriv, and choose “Float” as the 
type of value. Then press OK 

 

 

 

 

 

 

 

 
 

38. You should now see that the field that you have created has been added to the attribute to the far 
right of the table. 

39. Now we will populate this field using the data that we already have in our attribute table. 

40. Right click on the label of the new variable you created “PctPriv” and select “Field Calculator”.   

41. When you open your Field Calculator 
window, you want to create the 
following formula  

[PRIV] / [TOT_Bank]  

by choosing from the Fields drop down 

menu. 

 

42. When you have created the same 
formula as you see to the right, press 
OK. 
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43. After a few moments, you will see that the field you 
created is populated with your calculation  

 

 

 

 

 

44. Now, if you want, you can follow the same steps as above to calculate the percent of Banks that 
are government owned per town. 

45. Remember, you can always collapse any of these data by using the summarize tool that we used 
at the beginning of the exercise to understand values by a larger aggregation (Woreda, Zone, or 
Region) and recalculate percentages if needed. 

46. Now that we have calculated percent of Banks that are privately owned, let‟s map these to see 
where the largest share of private banks are located. 

47. Double click on the “Banks2” shapefile, in order to go to the Layer Properties window. Under the 
Quantities option under the Show field, choose “Graduated Symbols”. Under the Value field, 
choose your new variable “PctPriv”.  And then press Apply and OK. 

48. Drag your “Cities” layer above the “Banks2” layer in your table of contents, and classify your cities 
by Cities under 50,000 and Cities over 50,000. Notice how the larger share of private banks tend 
to be near larger cities. 

49. Classify your “Roads” data. Notice how most “Banks” follow the Road infrastructure of the 
country, and the larger proportion of private banks are on major roads. 

50. When you are finished, your output should look something like the map below. Remember 
though, you can create many tabular statistics using the attribute table in ArcGIS that may be 
better represented in a Table format instead of a Map format. This depends on what you are 
trying to communicate. 

Usually a mixture of tables, graphs and maps are the best way to communicate data 


